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A. Overview 

Microcontroller Driver Suite v10.4 is a software management system that generates C code to create, 
configure, optimize, migrate and deliver software components, such as peripheral drivers, for 
ColdFire+, Kinetis and Vybrid processors. The driver suite is delivered and installed as a 
comprehensive product with the Eclipse 4.2 (Juno) IDE. It is also available as an Eclipse plug-in for 

existing Eclipse 3.7 (Indigo)  and Eclipse 4.2 (Juno) installations. The driver suite does not include a 
compiler or linker. You merge the generated code into a build system. This functionality is integrated 
into the CodeWarrior tools. The driver suite provides the same kind of support for our ecosystem tools 
partners. This extends Processor Expert software functionality to non-CodeWarrior IDE users for the 
supported platforms.  
 
The Processor Expert technology packaged in the driver suite makes it much easier to optimize the 
low-level intricacies of a hardware platform. Eliminating the necessity for one-size-fits-all drivers, the 
driver suite allows you to design custom peripheral drivers ideally suited to your needs, without the 
need for extensive hardware knowledge.  

    
For the Kinetis devices, the following compilers are supported:  

• CodeWarrior ARM C Compiler 5.1 and higher (CodeWarrior for MCU v10.1 and higher) 
• IAR ARM C Compiler 6.3 and higher 
• GNU C Compiler for ARM architecture 
• Keil C/C++ ARM Compiler 5.4 and higher  

 
For the ColdFire+ devices, the following compilers are supported:  

• CodeWarrior ColdFire C Compiler 6.0 and higher (CodeWarrior for MCU v10.1 and higher) 
• IAR ColdFire C Compiler 1.2  
• GNU C Compiler for ColdFire architecture  

 
   For the Vybrid devices, the following compilers are supported:  

• IAR ARM compiler 6.3 and higher 
• GNU C Compiler for ARM architecture 
• DS-5 Arm C/C++ compiler 5.01 and higher 

B. What’s New 

• New Device Support:  
o Kinetis E Series: KE04Z, KE06Z 
o Kinetis EA Series: KEAZN128 

• Major new features: 
o New Component Inspector 
o Updated Component Development Environment 

C. Specifications 

 Operational Minimum Configuration 
o 1.8 GHz Pentium® compatible processor or better 
o 1 GB RAM 
o 1 GB hard disk space, 400 MB on Windows system disk 
 

 Host Operating System Support: 
o Microsoft® Windows XP 32-bit and 64-bit (Professional Edition) 
o Microsoft Windows Vista® 32-bit and 64-bit (Home Premium Edition and Business 

Edition) 
o Microsoft Windows 7 32-bit and 64-bit (Home Premium Edition and Professional Edition) 
o Microsoft Windows 8 32-bit and 64-bit (Professional Edition) 
o Linux Ubuntu 10.4 32-bit and 64-bit 
o Linux Red Hat Enterprise 6 32-bit and 64-bit  
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 Other requirements: 
o Acrobat Reader 5.0 or higher 

D. Installation 

The Microcontrollers Driver Suite product offers two installation options - a full product installation 
(which includes its own eclipse environment) and an update package for Eclipse IDE C and C++ 
developers 4.2.x (to be installed into an already existing eclipse environment). Full product installation 
is available for Windows machines only. 
 
Full product installation  
 
To install Processor Expert Software - Microcontrollers Driver Suite, double-click the installation 
package and a wizard will guide you through the installation process. There is no license necessary 
to run this product.  
 
Eclipse plugin installation   
 
To install the Processor Expert Software - Microcontrollers Driver Suite eclipse plugin, follow these 
installation instructions.  

 
1. If you haven’t installed Eclipse yet you can download the latest supported version of Eclipse IDE 

for C/C++ developers from here:  
http://www.eclipse.org/downloads/packages/release/juno/sr2 

o To install Eclipse, unpack the downloaded zip file in a directory. No further work is 
required (other than making sure you have a Java Runtime Engine installed). 

o Refer the link below for additional details: 
http://wiki.eclipse.org/FAQ_Where_do_I_get_and_install_Eclipse%3F 

 
2. Unzip the installation package (the DriverSuite_10.4_Install_into_Eclipse_3.7_4.2.zip archive). 
 
3. Run the eclipse.exe to start the IDE.  
 
4. Install the Freescale Eclipse Updater by selecting Help > Install New Software.  
 
5. Add a new install site using the Add button. 
 
6. Type name of the install site into the Name field (e.g. Updater).  
 
7. Select Archive... and find the com.freescale.eclipse3.7-4.2.updater.custom.updatesite.zip.  
 
8. Select the Eclipse Freescale Solution category checkbox and click Next. 
 
9. Continue with the wizard. Accept the license agreement during the installation process.  
 
10. Restart Eclipse.  
 
11. Install the Processor Expert plug-in by selecting Help > Install New Software.  
 
12. Add a new install site using the Add button. 
 
13. Type name of the install site into the Name field (e.g. PExDrv). 
 
14. Select Archive... and find the PExDriverSuite_v10.4_eclipse.zip file.  
 
15. Select the Processor Expert Microcontrollers Driver Suite 10.4 category checkbox and click Next. 
 
16. Continue with the wizard. Accept the license agreement during the installation process. 
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17. Restart Eclipse.  
 
18. Open Processor Expert windows by selecting menu command Processor Expert > Show Views. 

Rearrange Processor Expert windows to suit your needs. 

E. How to create a new Processor Expert project  

1. To create a new project select the menu command File > New > Processor Expert Project.  

2. Enter project name.  

3. Select derivative for the project.  

4. Select project type - Processor Expert.  

5. Select the target compiler the code will be generated for.  

6. Click Finish. A new Processor Expert Project will be created.  
 

When using generated files in a third party environment (e.g. IAR Embedded Workbench) a correct 
path to header files stored in the folder ProcessorExpert\lib must be set and the linker file generated 
by Processor Expert must be used. Detailed instructions can be found in the Getting Started Guide 
(PEXDRVSGETSTARTEDUG.pdf), located in the ProcessorExpert\Help folder. 

F. How to create a new Processor Expert MQX-Lite project  

1. To create a new project select the menu command File -> New -> Processor Expert MQX-
Lite Project.  

2. Enter project name.  

3. Select derivative for the project.  

4. Select the target compiler the code will be generated for.  

5. Click Finish. A new Processor Expert MQX-Lite Project will be created.  
 
When using generated files in a third party environment (e.g. IAR Embedded Workbench) a correct 
path to header files stored in the folder ProcessorExpert\lib must be set and the linker file generated 
by Processor Expert must be used. Detailed instructions can be found in the Getting Started Guide 
(PEXDRVSGETSTARTEDUG.pdf), located in the ProcessorExpert\Help folder. 

G. Product Content 

Detailed information about the components can be found in the documentation. Please refer to  
"Help > Help Contents > Processor Expert Software - Microcontrollers Driver Suite" in the Eclipse 
main menu. 

 

 Documentation - The following user guides are provided as a part of the installation package: 
o Installation Guide - PEXDRVSINSTALLUG.pdf 
o Getting Started Guide - PEXDRVSGETSTARTEDUG.pdf 
o Processor Expert User Guide - PEXDRVSPEXUG.pdf   

 Components 
 

1. Kinetis K CPU Components  
o MK10DN512ZVLK10, MK10DN512ZVLL10, MK10DN512ZVLQ10, MK10DN512ZVMB10, 

MK10DN512ZVMC10, MK10DN512ZVMD10  
o MK10DX256ZVLQ10, MK10DX256ZVMD10  
o MK10DX128ZVLQ10, MK10DX128ZVMD10  
o MK20DN512ZVLK10, MK20DN512ZVLL10, MK20DN512ZVLQ10, MK20DN512ZVMB10, 

MK20DN512ZVMC10, MK20DN512ZVMD10  
o MK20DX128ZVMD10, MK20DX128ZVLQ10  
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o MK20DX256ZVLK10, MK20DX256ZVLL10, MK20DX256ZVLQ10, MK20DX256ZVMB10, 
MK20DX256ZVMC10, MK20DX256ZVMD10  

o MK30DN512ZVLK10, MK30DN512ZVLL10, MK30DN512ZVLQ10, MK30DN512ZVMB10, 
MK30DN512ZVMC10, MK30DN512ZVMD10  

o MK30DX128ZVLQ10, MK30DX128ZVMD10  
o MK30DX256ZVLQ10, MK30DX256ZVMD10  
o MK40DN512ZVLK10, MK40DN512ZVLL10, MK40DN512ZVLQ10, MK40DN512ZVMB10, 

MK40DN512ZVMC10, MK40DN512ZVMD10  
o MK40DX128ZVLQ10, MK40DX128ZVMD10  
o MK40DX256ZVLQ10, MK40DX256ZVMD10  
o MK50DN512ZCLL10, MK50DN512ZCLQ10, MK50DN512ZCMC10, 

MK50DN512ZCMD10  
o MK50DX256ZCLK10, MK50DX256ZCLL10, MK50DX256ZCMB10, MK50DX256ZCMC10  
o MK51DN512ZCLL10, MK51DN512ZCLQ10, MK51DN512ZCMC10, 

MK51DN512ZCMD10  
o MK51DN256ZCLQ10, MK51DN256ZCMD10  
o MK51DX256ZCLK10, MK51DX256ZCLL10, MK51DX256ZCMB10, MK51DX256ZCMC10  
o MK52DN512ZCLQ10, MK52DN512ZCMD10  
o MK53DN512ZCLQ10, MK53DN512ZCMD10  
o MK53DX256ZCLQ10, MK53DX256ZCMD10  
o MK60DN256ZVLL10, MK60DN256ZVLQ10, MK60DN256ZVMC10, 

MK60DN256ZVMD10,  
o MK60DN512ZVLL10, MK60DN512ZVLQ10, MK60DN512ZVMC10, 

MK60DN512ZVMD10  
o MK60DX256ZVLL10, MK60DX256ZVLQ10, MK60DX256ZVMC10, MK60DX256ZVMD10  
o MK10FN1M0VLQ12, MK10FX512VLQ12, MK10FN1M0VMD12, MK10FX512VMD12  
o MK20FN1M0VLQ12, MK20FX512VLQ12, MK20FN1M0VMD12, MK20FX512VMD12  
o MK60FN1M0VLQ12, MK60FX512VLQ12, MK60FN1M0VMD12, MK60FX512VMD12  
o MK60FN1M0VLQ15, MK60FX512VLQ15, MK60FN1M0VMD15, MK60FX512VMD15  
o MK70FN1M0VMJ12, MK70FX512VMJ12, MK70FN1M0VMJ15, MK70FX512VMJ15  
o MK10DN128VLH5, MK10DN128VMP5, MK10DN128VFT5, MK10DN128VLF5, 

MK10DN128VFM5  
o MK10DN32VLH5, MK10DN32VMP5, MK10DN32VFT5, MK10DN32VLF5, 

MK10DN32VFM5  
o MK10DN64VLH5, MK10DN64VMP5, MK10DN64VFT5, MK10DN64VLF5, 

MK10DN64VFM5  
o MK10DX128VLH5, MK10DX128VMP5, MK10DX128VFT5, MK10DX128VLF5, 

MK10DX128VFM5  
o MK10DX32VLH5, MK10DX32VMP5, MK10DX32VFT5, MK10DX32VLF5, 

MK10DX32VFM5  
o MK10DX64VLH5, MK10DX64VMP5, MK10DX64VFT5, MK10DX64VLF5, 

MK10DX64VFM5  
o MK20DN128VLH5, MK20DN128VMP5, MK20DN128VFT5, MK20DN128VLF5, 

MK20DN128VFM5  
o MK20DN32VLH5, MK20DN32VMP5, MK20DN32VFT5, MK20DN32VLF5, 

MK20DN32VFM5  
o MK20DN64VLH5, MK20DN64VMP5, MK20DN64VFT5, MK20DN64VLF5, 

MK20DN64VFM5  
o MK20DX128VLH5, MK20DX128VMP5, MK20DX128VFT5, MK20DX128VLF5, 

MK20DX128VFM5  
o MK20DX32VLH5, MK20DX32VMP5, MK20DX32VFT5, MK20DX32VLF5, 

MK20DX32VFM5  
o MK20DX64VLH5, MK20DX64VMP5, MK20DX64VFT5, MK20DX64VLF5, 

MK20DX64VFM5  
o MK10DN512VLQ10, MK10DN512VMD10, MK10DN512VMB10, MK10DN512VMC10, 

MK10DN512VLL10, MK10DN512VLK10,  
o MK10DX128VLQ10, MK10DX128VMD10,  
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o MK10DX256VLQ10, MK10DX256VMD10,  
o MK20DN512VLQ10, MK20DN512VMD10, MK20DN512VMB10, MK20DN512VMC10, 

MK20DN512VLL10, MK20DN512VLK10,  
o MK20DX128VLQ10, MK20DX128VMD10,  
o MK20DX256VLQ10, MK20DX256VMD10, MK20DX256VMC10,  
o MK30DN512VLQ10, MK30DN512VMD10, MK30DN512VMB10, MK30DN512VMC10, 

MK30DN512VLL10, MK30DN512VLK10,  
o MK30DX128VLQ10, MK30DX128VMD10,  
o MK30DX256VLQ10, MK30DX256VMD10, MK40DN512VLQ10, MK40DN512VMD10,  
o MK40DN512VMB10, MK40DN512VMC10, MK40DN512VLL10, MK40DN512VLK10,  
o MK40DX128VLQ10, MK40DX128VMD10,  
o MK40DX256VLQ10, MK40DX256VMD10,  
o MK50DN512CLQ10, MK50DN512CMD10, MK50DN512CMC10, MK50DN512CLL10,  
o MK50DX256CMB10, MK50DX256CMC10, MK50DX256CLL10, MK50DX256CLK10,  
o MK51DN256CLQ10, MK51DN256CMD10,  
o MK51DN512CLQ10, MK51DN512CMD10, MK51DN512CMC10, MK51DN512CLL10,  
o MK51DX256CMB10, MK51DX256CMC10, MK51DX256CLL10, MK51DX256CLK10,  
o MK52DN512CLQ10, MK52DN512CMD10,  
o MK53DN512CLQ10, MK53DN512CMD10,  
o MK53DX256CLQ10, MK53DX256CMD10,  
o MK60DN256VLQ10, MK60DN256VMD10, MK60DN256VMC10, MK60DN256VLL10,  
o MK60DN512VLQ10, MK60DN512VMD10, MK60DN512VMC10, MK60DN512VLL10,  
o MK60DX256VLQ10, MK60DX256VMD10, MK60DX256VMC10, MK60DX256VLL10  
o MK10DX128VMB7, MK10DX128VML7, MK10DX128VLL7, MK10DX128VLK7, 

MK10DX128VLH7,  
o MK10DX256VMB7, MK10DX256VML7, MK10DX256VLL7, MK10DX256VLK7, 

MK10DX256VLH7,  
o MK10DX64VMB7, MK10DX64VLK7, MK10DX64VLH7,  
o MK20DX128VMB7, MK20DX128VML7, MK20DX128VLL7, MK20DX128VLK7, 

MK20DX128VLH7,  
o MK20DX256VMB7, MK20DX256VML7, MK20DX256VLL7, MK20DX256VLK7, 

MK20DX256VLH7,  
o MK20DX64VMB7, MK20DX64VLK7, MK20DX64VLH7, MK30DX128VMB7,  
o MK30DX128VML7, MK30DX128VLL7, MK30DX128VLK7, MK30DX128VLH7,  
o MK30DX256VMB7, MK30DX256VML7, MK30DX256VLL7, MK30DX256VLK7, 

MK30DX256VLH7,  
o MK30DX64VMB7, MK30DX64VLK7, MK30DX64VLH7,  
o MK40DX128VMB7, MK40DX128VML7, MK40DX128VLL7, MK40DX128VLK7, 

MK40DX128VLH7,  
o MK40DX256VMB7, MK40DX256VML7, MK40DX256VLL7, MK40DX256VLK7, 

MK40DX256VLH7,  
o MK40DX64VMB7, MK40DX64VLK7, MK40DX64VLH7,  
o MK50DX128CMB7, MK50DX128CLK7, MK50DX128CLH7,  
o MK50DX256CMB7, MK50DX256CML7, MK50DX256CLL7, MK50DX256CLK7,  
o MK51DX128CMB7, MK51DX128CLK7, MK51DX128CLH7,  
o MK51DX256CMB7, MK51DX256CML7, MK51DX256CLL7, MK51DX256CLK7 
 
o MK21FN1M0MD12, MK21FN1M0MC12, MK21FN1M0LQ12 
o MK22FN1M0MD12, MK22FN1M0MC12, MK22FN1M0LQ12, MK22FN1M0LL12, 

MK22FN1M0LK12, MK22FN1M0LH12 
 
o MK24FN1M0LQ12, MK24FN1M0DC12 
o MK63FN1M0MD12, MK63FN1M0LQ12 
o MK64FN1M0MD12, MK64FN1M0LQ12, MK64FN1M0LL12, MK64FN1M0DC12 
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2. Kinetis E CPU Components  
o MKE02Z64LC2, MKE02Z64LD2, MKE02Z64QH2 
o MKE04Z8VTG4, MKE04Z8VWJ4, MKE04Z8VFK4 
o MKE04Z128xxx4, MKE04Z64xxx4 
o MKE06Z128xxx4, MKE06Z64xxx4 
o SKEAZ128xxx4, SKEAZ64xxx4 
o SKEAZN64MLH2, SKEAZN64MLD2, SKEAZN64MLC2 
o SKEAZN32MLH2, SKEAZN32MLD2, SKEAZN32MLC2 
o SKEAZN16MLD2, SKEAZN16MLC2 
o SKEAZN8MFK4, SKEAZN8MTG4 
 

3. Kinetis L CPU Components  
o MKL02Z32AF4, MKL02Z32FG4, MKL02Z32FK4, MKL02Z32FM4 
o MKL04Z32VLF4, MKL04Z32VFM4, MKL04Z32VLC4, MKL04Z32VFK4  
o MKL04Z8VFM4, MKL04Z8VLC4, MKL04Z8VFK4  
o MKL05Z16VLF4, MKL05Z16VFM4, MKL05Z16VLC4, MKL05Z16VFK4  
o MKL05Z32VLF4, MKL05Z32VFM4, MKL05Z32VLC4, MKL05Z32VFK4  
o MKL05Z8VFM4, MKL05Z8VLC4, MKL05Z8VFK4, MKL14Z32VLK4  
o MKL14Z32VLH4, MKL14Z32VFT4, MKL14Z32VFM4, MKL14Z64VLK4  
o MKL14Z64VLH4, MKL14Z64VFT4, MKL14Z64VFM4  
o MKL15Z128VLK4, MKL15Z128VLH4, MKL15Z128VFT4, MKL15Z128VFM4  
o MKL15Z32VLK4, MKL15Z32VLH4, MKL15Z32VFT4, MKL15Z32VFM4  
o MKL15Z64VLK4, MKL15Z64VLH4, MKL15Z64VFT4, MKL15Z64VFM4  
o MKL16Z128FM4, MKL16Z128FT4, MKL16Z256LH4, MKL16Z256LK4 
o MKL24Z32VLK4, MKL24Z32VLH4, MKL24Z32VFT4, MKL24Z32VFM4  
o MKL24Z64VLK4, MKL24Z64VLH4, MKL24Z64VFT4, MKL24Z64VFM4  
o MKL25Z128VLK4, MKL25Z128VLH4, MKL25Z128VFT4, MKL25Z128VFM4  
o MKL25Z32VLK4, MKL25Z32VLH4, MKL25Z32VFT4, MKL25Z32VFM4  
o MKL25Z64VLK4, MKL25Z64VLH4, MKL25Z64VFT4, MKL25Z64VFM4  
o MKL26Z128FM4, MKL26Z128FT4, MKL26Z256LH4, MKL26Z256LK4, MKL26Z256LL4, 

MKL26Z256MC4 
o MKL34Z64LH4, MKL34Z64LL4  
o MKL36Z256LH4, MKL36Z256LL4, MKL36Z256MC4  
o MKL46Z256LH4, MKL46Z256LL4, MKL46Z256MC4 
 

4. Kinetis V CPU Components  
o MKV10Z32LC7, MKV10Z32LF7, MKV10Z32FM7 
o MKV10Z16LC7, MKV10Z16LF7, MKV10Z16FM7 
     

5. ColdFire+ CPU Components  
o MCF51JF128, MCF51JF64, MCF51JF32  
o MCF51JU128, MCF51JU64, MCF51JU32  
o MCF51QU128, MCF51QU64, MCF51QU32  
o MCF51QM128, MCF51QM64, MCF51QM32  
o MCF51JG256, MCF51JG128, MCF51JG64 
            

6. Vybrid CPU Components 
o SVF311R3KU2, SVF312R3KU2 
o SVF321R3KU2, SVF322R3KU2 
o SVF332R3KU2 
o SVF511R3MK4, SVF512R3MK4 
o SVF521R3MK4, SVF522R3MK4 
o SVF522R2MK4, SVF532R3MK4 
o MVF30NN151KU26 
o MVF50NN151MK40, MVF50NN151MK50 
o MVF51NN151MK50 
o MVF60NN151MK40, MVF60NN151MK50 



Processor Expert Software - Microcontrollers Driver Suite 10.4 

 

  8 

o MVF61NN151MK50 
o MVF62NN151MK40 
 

7. Logical Device Driver Components 
o ADC_LDD 
o AnalogComp_LDD 
o ASRC_LDD 
o BitIO_LDD 
o BitsIO_LDD 
o CAN_LDD 
o Capture_LDD 
o CMT_LDD 
o CRC_LDD 
o DAC_LDD 
o DMA_LDD 
o DMAChannel_LDD 
o DMATransfer_LDD 
o Ethernet_LDD 
o EventCntr_LDD 
o ExtInt_LDD 
o FLASH_LDD 
o FreeCntr_LDD 
o GPIO_LDD 
o I2C_LDD 
o LCDC_LDD 
o NFC_LDD 
o OCOTP_LDD 
o PPG_LDD 
o PWM_LDD 
o RealTime_LDD 
o RNG_LDD 
o RTC_LDD 
o SDHC_LDD 
o SegLCD_LDD 
o Serial_LDD 
o Shared_LDD 
o SPDIF_LDD 
o SPIMaster_LDD 
o SPISlave_LDD 
o SSI_LDD 
o TimeDate_LDD 
o TimerInt_LDD 
o TimerOut_LDD 
o TimerUnit_LDD 
o TSI_LDD 
o USB_LDD 
o WatchDog_LDD 

 
8. High level components 

o ADC 
o AsynchroSerial 
o BasicProperties 
o BitIO 
o BitsIO 
o ByteIO 
o Capture 
o ConsoleIO 



Processor Expert Software - Microcontrollers Driver Suite 10.4 

 

  9 

o DAC 
o DMAController 
o EventCntr16 
o EventCntr32 
o EventCntr8 
o ExternalFile 
o ExtInt 
o FreeCntr 
o FreeCntr16 
o FreeCntr32 
o FreeCntr8 
o FreescaleAnalogComp 
o InternalI2C 
o InterruptVector 
o IntFLASH 
o PPG 
o PWM 
o StringList 
o SynchroMaster 
o SynchroSlave 
o TimeDate 
o TimerInt 
o TimerOut 
o TSS_Library 
o TwoKeys 
o WatchDog 
          

9. RTOS adapters for Logical Device Drivers 
o Bareboard 
o MQX 
o MQXLite 
 

10. Peripheral Initialization Components 
o Init_ACMP_VAR1 
o Init_ADC_VAR0 
o Init_ADC_VAR3 
o Init_ADC_VYBRID 
o Init_AFE_VYBRID 
o Init_AIPS0_VAR0 
o Init_AIPS1_VAR0 
o Init_ASRC_VYBRID 
o Init_AXBS_VAR0 
o Init_CAN_VAR0 
o Init_CAN_VAR1 
o Init_CAN_VYBRID 
o Init_CMT_VAR0 
o Init_CMU_VYBRID 
o Init_COP_COLDFIREPLUS 
o Init_COP_KINETIS 
o Init_CRC_VAR0 
o Init_CRC_VYBRID 
o Init_DAC_VAR0 
o Init_DAC_VAR4 
o Init_DAC_VYBRID 
o Init_DCU_VYBRID 
o Init_DDR_KINETIS 
o Init_DDR_VYBRID 
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o Init_DMA_VAR0 
o Init_DMAMUX_VAR0 
o Init_eDMA_VAR0 
o Init_eDMA_VYBRID 
o Init_ENET_VAR0 
o Init_ENET_VYBRID 
o Init_ESAI_VYBRID 
o Init_ESW_VYBRID 
o Init_EWM_VAR0 
o Init_EWM_VYBRID 
o Init_ExternalBus_VYBRID 
o Init_FB_VAR0 
o Init_FMC_VAR0 
o Init_FMC_VAR1 
o Init_FTFL_VAR0 
o Init_FTM_VAR0 
o Init_FTM_VAR1 
o Init_FTM_VYBRID 
o Init_FTMR_VAR0 
o Init_GIC_VYBRID 
o Init_GPC_VYBRID 
o Init_GPIO_VAR0 
o Init_GPIO_VAR1 
o Init_GPIO_VYBRID 
o Init_GPU2D_VYBRID 
o Init_HSCMP_VAR0 
o Init_I2C_VAR0 
o Init_I2C_VYBRID 
o Init_I2S_VAR0 
o Init_I2S_VAR1 
o Init_I2S_VYBRID 
o Init_IRQ_VAR0 
o Init_KBI_VAR0 
o Init_LCD_VYBRID 
o Init_LCDC_VAR0 
o Init_LLWU_VAR0 
o Init_LPTMR_VAR0 
o Init_LPTMR_VYBRID 
o Init_MCM_VAR2 
o Init_MCM_VAR3 
o Init_MLB_VYBRID 
o Init_MPU_VAR0 
o Init_MSCM_VYBRID 
o Init_MTIM_VAR0 
o Init_NFC_VAR0 
o Init_NFC_VYBRID 
o Init_NVIC_VAR0 
o Init_NVIC_VAR1 
o Init_OCOTP_VYBRID 
o Init_OPAMP_VAR0 
o Init_PDB_VAR0 
o Init_PDB_VYBRID 
o Init_PGA_VAR0 
o Init_PIT_VAR0 
o Init_PIT_VYBRID 
o Init_PMC_VAR0 
o Init_PMC_VAR2 
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o Init_PORT_VAR0 
o Init_PORT_VAR1 
o Init_PWT_VAR0 
o Init_QuadSPI_VYBRID 
o Init_RCM_VAR0 
o Init_RGPIO_VAR0 
o Init_RLE_DEC_VYBRID 
o Init_RNG_VAR0 
o Init_RNG_VAR1 
o Init_RTC_VAR0 
o Init_RTC_VAR1 
o Init_SCB_VAR0 
o Init_SDHC_VAR0 
o Init_SDHC_VYBRID 
o Init_SIM_VAR2 
o Init_SIM_VAR3 
o Init_SIM_VAR4 
o Init_SLCD_VAR0 
o Init_SMC_VAR0 
o Init_SPDIF_VYBRID 
o Init_SPI_VAR0 
o Init_SPI_VAR1 
o Init_SPI_VYBRID 
o Init_SRC_VYBRID 
o Init_SRTC_VAR0 
o Init_SysTick_VAR0 
o Init_TCON_VYBRID 
o Init_TPM_VAR0 
o Init_TRIAMP_VAR0 
o Init_TSI_VAR0 
o Init_TSI_VAR2 
o Init_TSI_VAR3 
o Init_UART_VAR0 
o Init_UART_VYBRID 
o Init_USB_OTG_HS_VAR0 
o Init_USB_OTG_VAR0 
o Init_USB_VYBRID 
o Init_USBDCD_VAR0 
o Init_USBPHY_VYBRID 
o Init_VDEC_VYBRID 
o Init_VIU3_VYBRID 
o Init_VREF_VAR0 
o Init_WDOG_VAR0 
o Init_WDOG_VYBRID 
o Init_WKPU_VYBRID  
o PinSettings 
 

11. PDD Modules 
o ADC_PDD 
o ASRC_PDD 
o CAN_PDD 
o CCM_PDD 
o CMP_PDD 
o CMT_PDD 
o COP_PDD 
o CRC_PDD 
o DAC_PDD 
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o DMAMUX_PDD 
o DMA_PDD 
o ENET_PDD 
o EWM_PDD 
o FMC_PDD 
o FTFA_PDD 
o FTFE_PDD 
o FTFL_PDD 
o FTMRE_PDD 
o FTMRH_PDD 
o FTM_PDD 
o GIC_PDD 
o GPIO_PDD 
o I2C_PDD 
o I2S_PDD 
o IOMUXC_PDD 
o IRQ_PDD 
o KBI_PDD 
o LCDC_PDD 
o LCD_PDD 
o LLWU_PDD 
o LPTMR_PDD 
o MCG_PDD 
o MCM_PDD 
o MSCAN_PDD 
o NFC_PDD 
o NVIC_PDD 
o OCOTP_PDD 
o OSC_PDD 
o PDB_PDD 
o PDD_Types 
o PIT_PDD 
o PMC_PDD 
o PORT_PDD 
o PWT_PDD 
o RCM_PDD 
o RNGA_PDD 
o RNG_PDD 
o RTC0_PDD 
o RTC_PDD 
o SAI_PDD 
o SCB_PDD 
o SDHC_PDD 
o SIM_PDD 
o SMC_PDD 
o SPDIF_PDD 
o SPI_PDD 
o SysTick_PDD 
o TPM_PDD 
o TSI_PDD 
o UART0_PDD 
o UART_PDD 
o USBDCD_PDD 
o USBHS_PDD 
o USB_PDD 
o WDOG_PDD 
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H. Known problems and limitations  

 General limitations: 
o Component Licensing is not supported on 64-bit Eclipse. 

 

 Kinetis limitations: 
o CAN_LDD - due to silicon 1.0 limitation the CAN will work only when System Oscillator in 

CPU component is enabled 
- (Clock settings\System oscillator) and OSCERCLK clock is enabled 
- (Clock settings\Clock configuration\External reference clock\OSCERCLK clock). 

o SSI_LDD - due to silicon 1.0 problems with prescalers in System Integration module these 
prescalers are not used by SSI_LDD component.  
 

 Vybrid limitations: 
o Tested with Eclipse 4.2 
o No dual-core support. Only A5 core supported in the generated code. 
o Vybrid silicon 1.1 supported and used for testing. 
o PinSettings: After selecting a module pins under collapsed mode and switching to   expanded 

mode, other device will be selected (ENGR00236796). 
o Derivatives with security features (MVFxxNSxxx) are not included. They are supported by a 

separate service pack. 

I.  Processor Expert directory overview  

    ProcessorExpert\:  
       Beans\  - Components configuration files  
       Config\  - Actual configuration of Processor Expert(TM)  
       CPUs\  - CPU components configuration files  
       DOCs\  - Documentation and help files  
       Drivers\  - Contains component drivers  
       Help\  - Contains user guides  
       Lib\  - Contains platform depended static files  
       Lib\mqxlite  - Contains MQX-Lite source files  
       Projects\  - Demo, tutorial and test projects other Processor Expert files             

J.  Demo applications 

There are several example projects available in the Projects directory of Processor Expert. The 
examples are targeted for the following development boards:  

 
o FRDM-KL25Z  
o TWR-K20D72M  
o TWR-K40X256-KIT  
o TWR-K60N512-KIT  
o TWR-MCF51JF-KIT  
o TWR-K70F120-KIT 
o MQXLite  
o TWR-VF65GS10 

 
The example projects are targeted for GNU C, Keil ARM C and IAR C compilers.  
 
Note: All demo applications for IAR Embedded Workbench and Keil uVision assume a default 
Processor Expert Driver Suite installation directory “c:\Freescale\PExDrv v10.4” is used. If the product 
is installed in another directory, the demo projects must be updated to point to the new installation 
directory.  

 
The following compiler search path must be updated to point to the new installation directory: 
“c:\Freescale\PExDrv v10.4\eclipse\ProcessorExpert\lib\Kinetis\pdd\inc”.[p1] 



Processor Expert Software - Microcontrollers Driver Suite 10.4 

 

  14 

K. Revision history 

Processor Expert Software - Microcontrollers Driver Suite 10.4  

 Kinetis E family: 
o Support of new 48 MHz MKE04Z64 and MKE04Z128 derivatives 
o Support of new 48 MHz MKE06Z64 and MKE06Z128 derivatives. 

 Kinetis EA family: 
o Support of new 48 MHz and 48 MHz KEAZ128 derivatives. 

 

 Component Development Environment : 
o Component Development Environment v1.6 

 

 Fixed issues: 
o ENGR00300792 – Fixed issue which caused Processor Expert to hang during creation of a 

component requiring shared components that are configured via templates. 

o ENGR00290299 – Processor Expert Configuration Registers View shows registers from the 

previous processor after switch to another processor. The register list was not being updated 

if the peripheral for both processors shared the same name. This issue has been addressed. 

o ENGR00293019 - Fixed following error reported when importing a Processor Expert 

ColdFireV1 project with peripheral initialization components: 

o “ERROR: Peripheral Initialization component is not supported for selected target”   

o ENGR00297024 – Fixed configuration of the pin direction if user name (signal) is assigned to 

the pin. 

o ENGR00286843 - Fixed: Disabled processor components display processor variants in drop 
down list from selected processor components. 

o ENGR00286348 - Fixed deletion of multiple components. 

L. Where to find information 

This file contains last-minute information about Processor Expert and the Processor Expert Software - 
Microcontrollers Driver Suite. For detailed documentation, see the online Help that accompanies this 
release. License information is described in the file DOCs\EULA.txt 

 
World Wide Web 
http://www.freescale.com/processorexpert 
http://www.freescale.com/mqx 
http://www.freescale.com 
 
Address 
Freescale Semiconductor Inc. 
6501 William Cannon Drive West 
Austin, Texas 78735 
U.S.A. 
 
Freescale Support Department 
support@freescale.com 

 
 
 

 
 
 
 
Freescale, the Freescale logo, CodeWarrior, ColdFire+, Kinetis, and Processor Expert are trademarks of Freescale 
Semiconductor, Inc., Reg. U.S. Pat. & Tm. Off. All other product or service names are the property of their respective owners. 
ARM is the registered trademark of ARM Limited. © 2014 Freescale Semiconductor, Inc. 


